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Chapter 1—Welcome

iClipboard is the ultimate clipboard manager. It keeps a history of everything you copy to the system-wide clip-
board from any application. When you need to go back and paste a clipping from the history, iClipboard ap-
pears from the side of your screen so you can preview and paste any clipping—you're no longer limited to
pasting just the last thing copied to the clipboard. For a list of new features in this version please visit our web
site at http://www.chronosnet.com.

System Requirements

4 MacOS Xv10.6.8 or later
4 50MB of available disk space

Installing iClipboard (if downloaded from Chronos
website)

If you downloaded iClipboard from the Chronos website, you should see an iClipboard disk image on your
Desktop.

1) Open the iClipboard disk image on your desktop

2) Drag and drop the iClipboard application icon into your Applications folder or other folder of your choice.

What Gets Installed?

iClipboard does not install any additional software components when it runs.

Uninstall iClipboard
The below steps describe how to uninstall all of the components related to iClipboard.

1) Delete the iClipboard application. The iClipboard application was originally installed by you, so you are the
only one that knows where it is installed. That said, it is likely in your Applications folder.

2) Delete the “Chronos/iClipboard” folder. This folder is where iClipboard stores its database. This is located in the
“Application Support” folder of your home Library folder.

3) Delete the “iClipboardService.bundle”file. This file is located in the “Services” folder of your home Library folder.

4) Delete the “com.chronos.iClipboard.plist” file. This file is located in the “Preferences” folder of your home Library
folder.

Installing iClipboard (if purchased from the Mac
App Store)

If you purchased iClipboard from the Mac App Store, then the App Store application build into Mac OS X will
automatically download and install the application for you. By default, it will install iClipboard in your Applica-
tions folder.
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What Gets Installed?

iClipboard does not install any additional software components when it runs.

Uninstall iClipboard
The below steps describe how to uninstall all of the components related to iClipboard.

1) Delete the iClipboard application. Unless you manually moved the iClipboard application elsewhere, it
should be in your Applications folder.

2) Delete the “Chronos/iClipboard” folder. This folder is where iClipboard stores its database. This is located in the
“Application Support”folder of your home Library folder.

3) Delete the “com.chronos.iClipboard.plist” file. This file is located in the “Preferences” folder of your home Library
folder.

Learning to Use iClipboard

To learn how to use iClipboard, consult these resources:

User Guide

This guide describes iClipboard’s features and shows how to use the program.

Onscreen Help

Help tags are available for many of the items in iClipboard. To see the help tags, let the mouse pointer rest over
an item for a couple of seconds.

Technical Support

Chronos provides various support options for iClipboard. See http://www.chronosnet.com/Support/index.html
for technical support options.

Web Resources

Go to http://www.chronosnet.com/Products/index.html to get the latest software and updates.
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Chapter 2—Getting Started

iClipboard is little bit unique in that it’s a faceless background application. This means it doesn’t appear in the
Mac OS X Dock and doesn’t have a regular menu bar. Instead it runs in the background and only appears when
needed.

Launching iClipboard

Since iClipboard runs in the background, you can normally just launch it once and then leave it running indefi-
nitely.
To launch iClipboard:

1) Double-click the iClipboard application. The application will launch and a Welcome window will appear.
The Welcome window contains a video you can watch to quickly get acquainted with the software. The
Welcome window will also walk you through a few setup and informational steps.

Welcome to iClipboard

User Guide

Need help? Check the User
Guide under the Help menu.

Open User Guide »

Welcome to iClipboard

The best way to get to know iClipboard is to see it in action.

If you're new to iClipboard, watch this Getting Started video to see Video Tutorials
everything you can accomplish with this remarkable application. Learn how to get the most
out of iClipboard.
Click to Play @ Learn more »
(M Show this window when iClipboard opens | Continue |

2) Click Close to close the Welcome window and start using the software. At the top of your screen in the
menu bar, you'll see an iClipboard icon which opens a menu. The iClipboard menu always remains in the
menu bar no matter which application you're currently working in. It provides convenient access to key
functionality as well as your recent clippings.
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iCLIPBOARD
Open Shelf
Stop Recording
Preferences...
Help >
Application »
Quit iClipboard

PROJECTS
Lab >
Research >
Unfiled >

RECENT CLIPPINGS

3) You'll also notice a tab on the edge of the screen.
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4) Click the tab. The tab is connected to a window called the Shelf which is described in the next chapter.



iClipboard

0 items

The first time you launch iClipboard, the software is automatically added to the list of Login Items for your user
account. This means that iClipboard will automatically and conveniently launch each time you restart your
computer.

To view/edit your user account’s Login Items:
1) Open the System Preferences.

2) Click the Accounts preference pane.

3) Select your account.

4) Click the Login Items tab.

Quitting iClipboard

Because iClipboard is a background application, you can't quit it like you would for most applications. Instead,
you use the iClipboard menu in the menu bar.

To quit iClipboard:

1) Click the iClipboard icon in the menu bar and choose Quit iClipboard.

Changing Whether iClipboard Launches at System
Startup

You can change, at any time, whether or not you want iClipboard to be launched automatically whenever your
computer restarts.

To enable or disable iClipboard launching at system startup:
1) Click the iClipboard icon in the menu bar and choose Preferences.
2) Select the General tab.

3) Select or deselect Enable at system startup.



Chapter 3—Using iClipboard

iClipboard records everything copied to the system-wide clipboard (whenever you press Command-C or choose Edit

> Copy in any application). It will also remember everything copied between computer restarts, so you can liter-
ally go back weeks in time to find something that you copied. Each recorded item is called a clipping.

The Shelf

The Shelf, which appears on the edge of your screen or free floating wherever you last left it on your screen,
lists all of the clippings that have been recorded.

Search Field P — Project Menu
Find a clipping by vvord—l_ - Record clippings in
or phrase. projects you create.
Control Bar Drag Zone
Quickly paste, preview, Drag new content
& delete clippings. here.
Lo] B~
Tab 3 m:ommbody—— Clipboard History
Click to open and close —— [l tracsreand e giolar Review and paste
the Shelf, e recorded clippings.
that translates to a notebook
that's exceptionally thin and
2 O @ *
Status Bar
Shows the total number
of clippings.
Start/Stop Button Action Button
Stop and resume , Access iClipboard
recording in one click. S features.

Each clipping appears as a thumbnail that represents the content in the clipping. iClipboard can accurately pre-
sent thumbnails for standard clippings like the following:

Text (including rich text)

Graphics (supports all popular formats including jpeg, tiff, png, pdf, eps, etc.)
Web content (html/web archives)

Movies

Audio

Files

+ee e+

The Drag Zone is located at the top of the Shelf. The Drag Zone provides a place where you can drag new con-
tent directly to the Shelf.
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To open the Shelf and view the clippings:
1) Click the tab on the Shelf. The Shelf will slide out from the side of the screen.

2) OR press the designated Open/Close Shelf hot key (if the Shelf is in the floating position, you must use the
Open/Close Shelf hot key). For more information on the open/close hot key, see Opening/Closing The Shelf Us-

ing a Hot Key.
3) ORclick the iClipboard icon in the menu bar and choose Open Shelf.

To close the Shelf:
1) Click the tab on the Shelf. The Shelf will close.

2) OR press the designated Open/Close Shelf hot key (if the Shelf is in the floating position, you must use the
Open/Close Shelf hot key).

3) ORclick the iClipboard icon in the menu bar and choose Close Shelf.

To change the position of the Shelf on the screen:
1) Click the iClipboard icon in the menu bar and choose Preferences.
2) Select the General tab.

3) Choose a new screen position from the Position pop-up menu. You can choose to position the Shelf on the left
side or right side of your screen. If you have multiple monitors, you can choose to position the Shelf on the left
side or right side of your greater Desktop (you can't position the Shelf on the edge of a screen in the middle of
the greater Desktop). You can also choose a floating position which means the Shelf isn't tied to the edge of your
screen or Desktop and can be placed anywhere.

To change the appearance of the tab on the Shelf including its visibility:
1) Click the iClipboard icon in the menu bar and choose Preferences.
2) Select the General tab.

3) Choose a tab appearance from the Tab appearance pop-up menu. You can choose to have the tab appear at the
top, middle, or bottom of the Shelf. You can also choose to not have a tab at all which is useful if you find that
the tab covers other onscreen content.

To change the width of the Shelf on the screen:

Note: these steps are not applicable for a floating Shelf since a floating Shelf can be resized manually.
1) Click the iClipboard icon in the menu bar and choose Preferences.

2) Select the General tab.

3) Adjust the width slider accordingly.

To change the height of the Shelf on the screen:
Note: these steps are not applicable for a floating Shelf since a floating Shelf can be resized manually.
4) Click the iClipboard icon in the menu bar and choose Preferences.

5) Select the General tab.
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6) Choose your desired Shelf height from the Shelf Height pop-up menu. You have the following choices:

Auto-Adjustable. Choose this option if you want the Shelf to automatically adjust its height according to the

number of clippings recorded.

Fixed Large, Fixed Medium, Fixed Small. Choose these options if you want the the Shelf to alway be the
same height. You can choose to have it fixed at a small, medium, or large size.

User Adjustable. Choose this option if you want to click and drag the height of the Shelf using the window

resize control that will appear in the corner of the Shelf. You can resize the Shelf at any time with this option.

To change the behavior of how the Shelf opens/closes:

Note: these steps are not applicable for a floating Shelf since a floating Shelf can only be opened and closed us-
ing the Open/Close Shelf hot key.

Normally, the Shelf opens/closes by clicking on its tab. You can, however, change this behavior so the Shelf
opens when you move your mouse to the edge of the screen and closes when you move your mouse off of the
Shelf.

1) Click the iClipboard icon in the menu bar and choose Preferences.
2) Select the General tab.

3) SelectTurn hiding on

To enable/disable the Shelf:

If you don't plan on using the Shelf at all, you can disable it at any time and use other features in the software to

access your clippings.
1) Click the iClipboard icon in the menu bar and choose Preferences.

2) Select or deselect Enable Shelf.

Adding Clippings

iClipboard automatically records everything copied to the system-wide clipboard. The means whenever you press
Command-C or choose Edit > Copy in any application, the copied content is recorded by iClipboard and placed on

the Shelf. But there are other ways to get content onto the Shelf including dragging content to the Shelf and using
the controls within a clipping to grab selected content.

To drag content to the Shelf:

1) Click and drag content from any application to Shelf. If the Shelf is closed, it will automatically open and
you can drop the content on any clipping or on the Drag Zone. The clipping will be replaced with the new
content.

To control how the Shelf opens when dragging content to the Shelf:

Note: these steps are not applicable for a floating Shelf since a floating Shelf can only be opened and closed us-
ing the Open/Close Shelf hot key.

If the Shelf is closed when you drag content to it, the Shelf will need to open automatically for you. You can
choose to have the Shelf open automatically as soon as the mouse is over the Shelf’s tab or as soon as the
mouse hits the edge of the screen.

1) Click the iClipboard icon in the menu bar and choose Preferences.

2) Select the General tab.

12



3) Choose either the Dock Tab or Screen Edge option.

To replace a clipping with selected content in the current application:

1) Select some content in your application.

2) Open the Shelf

3) Locate the clipping whose contents you want replaced with the selected content from another application.

4) Click the Action button in the Control Bar and choose Grab Into Clipping.

2 O B %

Deleting Clippings

The occasion may arise when you want to delete a single clipping from the Shelf (like a password) or delete a bunch
of clippings at once.

To delete a clipping:
1) Locate the clipping that you want to delete.

2) Click the Delete button in the Control Bar.

@

To delete more than one clipping:

1)  Select more than one clipping. Hold down the shift key to select multiple contiguous clippings. Hold down the
command key to select multiple clippings in a non-contiguous fashion.

2) Click the Action button and choose Delete Selected.
To delete all clippings in the history:
1) Choose “All” from the Projects pop-up menu.

2) Make sure that no clippings are currently selected. You can deselect a selected clipping by clicking on it or by
clicking in the Drag Zone.

3) Click the Action button and choose Delete All.
To delete all clippings in the selected project:
1) Choose a project from the Projects pop-up menu.

2) Make sure that no clippings are currently selected. You can deselect a selected clipping by clicking on it or by
clicking in the Drag Zone.

3) Click the Action button and choose Delete All

Pasting a Clipping Into Another Application

iClipboard keeps a history of everything copied to the system-wide clipboard so you can go back at any time
and use the clippings again. iClipboard makes it easy to paste clippings into other applications.

13



To control whether formatted text is pasted as rich text or plain text:

A lot of text that gets copied to the system-wide clipboard contains formatting like font information, styles
(bold, italics, etc.), line height info, etc. Formatted text is often referred to as rich text. When you use iClipboard
to paste formatted text into another application, you can choose to have iClipboard strip all the formatting
from the text and paste it as plain text. This is useful when you want the pasted text to take on the formatting

of the receiving document. You can specify a default setting as to whether iClipboard pastes formatted text as
rich text or plain text.

1) Click the iClipboard icon in the menu bar and choose Preferences.

2) Select the Behaviors tab.

3) Choose therich text or plain text option.

IMPORTANT TIP: Make sure that you're not holding down any keys on the keyboard when you paste a clipping.

This includes not holding down the Shift, Control, Option, and Command modifier keys.

To quickly change if formatted text is pasted as rich text or plain text:

You can change the default setting as to whether iClipboard pastes formatted text as rich text or plain text by
simply pressing a hot key you choose.

1) Click the iClipboard icon in the menu bar and choose Preferences.

2) Select the Hot Keys tab.

3) Clickin the Reverse Formatted Text Pasting Behavior Hot Key field.
4) Enter a new hot key or click Clear to delete the existing hot key.

5) Press this hot key at any time to reverse the current behavior.

To paste a clipping into another application:

1) Switch to the application where you want the clipping pasted and then click in the document where you
want the clipping pasted.

2) Open the Shelf.
3) Double-click the clipping you want to paste.

To paste a clipping into another application using the Paste button:

1) Switch to the application where you want the clipping pasted and then click in the document where you
want the clipping pasted.

2) Open the Shelf.
3) Locate the clipping you want to paste.
4) Click the Paste button in the Control Bar.

To paste a clipping into another application using the Action menu:

1) Switch to the application where you want the clipping pasted and then click in the document where you
want the clipping pasted.

2) Open the Shelf.
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3) Locate the clipping you want to paste.

4) Click the Action button in the Control Bar and choose Paste as Rich Text or Paste as Plain Text.

To paste more than one clipping consecutively:

1)  Select more than one clipping. Hold down the shift key to select multiple contiguous clippings. Hold down the
command key to select multiple clippings in a non-contiguous fashion.

2) Click the Action button and choose Paste Selected.

To paste all the clippings in the current project or the entire history:
1) Choose a project or “All” from the Projects pop-up menu.

2) Make sure that no clippings are currently selected. You can deselect a selected clipping by clicking on it or by
clicking in the Drag Zone.

3) Click the Action button and choose Paste All.

To paste a clipping into another application using drag and drop:

1) Switch to the application where you want the clipping pasted.
2) Open the Shelf.

3) Click and drag the clipping from the Shelf to the document where you want the clipping pasted.

Previewing a Clipping

The Shelf only displays a thumbnail of each clipping since space is limited. If you need to see a larger version of
a clipping, you can bring up a preview.

15



http:/ /www.apple.com/ipad/features/
captured from Safari on 2/18/2012 at 4:26 PM
(shown at 77%)

Format size: 1.4 MB of 3 MB

iClipboard can show you previews of the following standard kinds of clippings:

Text (including rich text)

Graphics (supports all popular formats including jpeg, tiff, png, pdf, eps, etc.)
Web content (html/web archives)

Movies

Audio

Files

+e++ 44

The previews are dynamic in that movies and audio will play, and files will show you a Mac OS X Quick Look
preview of the file’s contents when available. If iClipboard tries to preview a non-standard or proprietary clip-
ping, the following preview symbol will appear:

Preview Not
Available

This symbol simply means that iClipboard can't display the contents of the clipping, but the clipping is still valid
and every bit as usable as any other clipping.

The preview will also show you other pertinent information about the clipping depending upon the kind of
clipping:

The kind of clipping (text, image, movie, etc.)

The size of the clipping in bytes

The document and application where the clipping came from
The URL where the web clipping came from, i.e. www.chronosnet.com

+4+4+ 4+
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4 The date and time the clipping occurred
To preview a clipping:
1) Locate the clipping you want to preview.

2) Click the Preview button in the Control Bar.

©

To dismiss a preview:

1) Click the Preview button in the Control Bar or click in the Shelf.

Choosing a Preview Format

When content is copied to the system-wide clipboard, the content might appear on the clipboard in different
data formats. For example, if you copy some text in your word processor, your word processor might put plain
text, rich text, and Unicode formats of the text on the clipboard to make it easier for other applications to use.
When you later paste the text in a different application like a spreadsheet program, that program can decide
which format of the content to paste. For example, an older spreadsheet program might not support Unicode
text so it would use the plain text format.

When you preview a clipping in iClipboard, the preview will show you all the different formats of the content
contained in the clipping. The format currently being displayed is selected in the Format button at the bottom
of the preview.

Format: " Rich'Text

Format size: 211 bytes of 2.6 KB

If you click on the Format button, you'll see all of the different formats stored in the clipping:

17



TEXT
Carbon Plain Text
Carbon Stylized Text
Carbon UTF-16 Plain Text
Carbon UTF-16 Stylized Text
Cocoa Rich Text

Rich Text

Traditional Mac Plain Text
UTF-16 Big Endian Plain Text
UTF-8 Plain Text

WEB ARCHIVE
Cocoa Web Archive
Web Archive

OTHER

¥ Cocoa Web Smart Paste

The formats are organized for your convenience into broad categories like text, images, web archives, etc. You
might not recognize some of the names of these formats because they're used internally by programmers and
some are proprietary, but many are identifiable.

ADVANCED FORMAT INFORMATION. You'll likely notice that many formats begin with either “Carbon” or “Co-
coa”. Carbon formats are generally used by older applications that were originally ported from Mac OS 9. Since
some older applications still rely on Carbon formats, some modern applications still put these formats on the
clipboard even though they're slowing becoming deprecated with each new Mac OS X release. Cocoa formats
were the modern replacement for Carbon formats, but they too have been superseded by Apple in recent years
by an even better standard known as Universal Type Identifier or UTI. The UTI formats appear without any prefix
so when you see “Rich Text", it’s really a UTI Rich Text format.

You can select a different format to see a preview of that format. Suppose, for example, that you copy an image
from a web page in your web browser application. It might show up on your Shelf like this:

o
.~
3]
[~}

8
a.

-4

When you preview this clipping, iClipboard, will do its best to choose the format of the content that it thinks
will best represent the clipping to you. In this case, it will choose the “tiff” graphics file format.

18



http:/ /www.apple.com/iphone/bullt-in-apps/
captured from Safari on 2/18/2012 at 4:08 PM
(shown at 100%)

Format size: 341.8 KB of 789.7 KB

However, if you look the listing of formats, you'll see that it also has a plain text flavor of the image called,
“public.utf8-plain-text”. Why would it have a text format of an image? Your web browser also stored a text for-
mat for the image in case you tried to paste the image into a text field. Since a text field can’t accept an image,
your web browser figured you might appreciate the URL of the image being pasted instead.

http:/ /www.apple.com/iphone/built-in-
captured from Safari on 2/18/2012 at 4:12 PM
78 characters

http/fwww.apple.com/iphone/includes/camera-gallery/
06.html#zoomerlay-gallery6

Format: ~ UTF-8 Plain Text

Format size: 78 bytes of 789.7 KB
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Starting/Stopping Recording

There may be times when you don't want iClipboard to record data that is copied to the system-wide clipboard.
In such cases, you can temporarily stop and resume recording from either the Shelf or the icon in the menu bar.
To stop recording from the Shelf:

1) Click Stop at the bottom of the Shelf.

The red LED will stop blinking on the Start/Stop button in the Shelf and you'll see a prominent red bar appear near
the top of the Shelf to remind you that recording has been stopped. The icon in the menu bar will also turn gray to
indicate recording has been stopped.

STOPPED

press Start to resume

To stop recording from the icon in the menu bar:
1) Choose Stop Recording from the icon in the menu bar.
[E] 4+ MW ¢ O = @& Tue43lPM Q

iCLIPBOARD
Open Shelf

Stop Recording

Preferences...

You'll see a prominent red bar appear at the top of the menu to remind you that recording has been stopped. The
icon in the menu bar will also turn gray to indicate recording has been stopped.

[E] 3 M ¢« O = @& Tue406PM Q

STOPPED
choose Start Recording to resume

iCLIPBOARD
Open Shelf
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To start recording from the Shelf:

1) Click Record at the bottom of the Shelf. The red LED will start blinking on the Start/Stop button in the Shelf.

To start recording from the icon in the menu bar:

1) Choose Start Recording from the icon in the menu bar.
[=] + ™ ¢ O = @ Tued:09PM Q
STOPPED

choose Start Recording to resume

iCLIPBOARD
Open Shelf

Preferences...

Opening a Clipping

You can open a clipping in another application if you want to edit the clipping or work with it. iClipboard will
open the clipping using the default application for the type of data stored in the clipping. For example, a rich
text clipping will most likely be opened by TextEdit; a jpeg image will most likely be opened by Preview or
other graphics editing program; and so forth.

To open a clipping:
1) Locate the clipping you want to open.

2) Click the Action button in the Control Bar and choose Open.

Opening/Closing The Shelf Using a Hot Key

Some may find it more convenient to open and close the Shelf using a hot key instead of clicking the tab on the
Shelf.

To change the hot key that opens and closes the Shelf:

1) Click the iClipboard icon in the menu bar and choose Preferences.

2) Select the Hot Keys tab.
3) Clickin the Open/Close Hot Key field.
4) Enter a new hot key or click Clear to delete the existing hot key.

Setting Grab and Paste Sounds

Whenever you grab content onto the Shelf (either by dragging or the Grab button), a special grab sound will
play so you know the content was grabbed. Likewise, whenever you paste a clipping into another application, a



special paste sound will play. You can change the sound that plays when these events occur or you can turn off
the sound effect altogether. You can also adjust the volume that these sounds play at in relation to the system
volume setting.

To change the grab and paste sounds:

1) Click the iClipboard icon in the menu bar and choose Preferences.

2) Select the Sounds tab.

3) Choose a new Grab or Paste sound from the appropriate pop-up menus.

4) Adjust the volume of these sounds as desired.

Setting The Copy Sound

iClipboard records everything copied to the system-wide clipboard. This means whenever you press Command-C or

choose Edit > Copy in any application, the copied content is recorded by iClipboard and placed on the Shelf. When
this occurs, you can optionally choose for the software to play a sound of your choice.

To change the copy sound:

1) Click the iClipboard icon in the menu bar and choose Preferences.

2) Select the Sounds tab.

3) Choose a new Copy sound from the Copy clipping sound pop-up menu.

4) Adjust the volume as desired.

iClipboard in The Menu Bar

The iClipboard menu always appears in the menu bar at the top of your screen. This menu displays clippings in

all of your projects as well as recent clippings from your history. You can use this menu to quickly paste any of
these clippings into the current application.
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iICLIPBOARD
Open Shelf
Stop Recording
Preferences...
Help >
Application -
Quit iClipboard

PROJECTS
Lab S
Research e
Unfiled S

RECENT CLIPPINGS

To paste a clipping into another application using iClipboard in the menu bar:
1) Switch to the application where you want the clipping pasted.

2) Click the iClipboard icon in the menu bar.

3) Choose a clipping from one of your projects or from the list of Recent Clippings.

To change the number recent clippings that appear in the iClipboard menu:
1) Click the iClipboard icon in the menu bar and choose Preferences.
2) Select the General tab.

3) Choose a limit from the Menu bar limit pop-up menu.
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Chapter 4—Advanced Features

iClipboard has many advanced features that help you manage you clippings and use clippings in useful ways.

Editing Clippings

You can edit text and web clipping directly from the Shelf. This is useful if you need to make a correction or
change to a clipping before pasting it into another application.

To edit a text or web clipping:
1) Locate the text or web clipping you want to edit.

2) Click the Action button in the Control Bar and choose Edit.

Assigning Names To Clippings For Pasting

You can assign a name to any clipping so you can later paste the clipping into another application by name. The
name you assign to a clipping appears beneath the clipping (“Keauhou Reservation”):

Reservation Policies

Room Rates:

Room rates are quoted in U.S.
Dollars (USD) per room, for two
persons. Room rates do not include
room service, restaurant meals,

To assign a name to a clipping:
1) Locate the clipping you wish to assign a name to.

2) Click the Action button in the Control Bar and choose Edit Name.

Pasting a Named Clipping Using Services Menu

IMPORTANT NOTE FOR MAC APP STORE CUSTOMERS. If you purchased iClipboard from the Mac App Store, you will
not be able to paste clippings using the Services menu as described below. Apple’s Mac App Store guidelines cur-
rently disallow this feature due to sandboxing restrictions which prohibit resources from being stored in shared loca-
tions. Apple added these sandboxing requirements to make your computer more secure by preventing rogue appli-
cations from accessing resources they're not supposed to. Chronos is working with Apple to come up with a solution
that works within the sandboxing requirements (Apple’s current method for providing dynamic services violates their
own requirements).

To paste a named clipping into another application:
1) Switch to another application such as a word processor, e-mail client, etc.

2) Choose Application Menu > Services, where Application Menu is the name of the application you're currently in.
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3) Choose iClipboard and then choose the name of the clipping you wish to paste. The contents of the clipping will
be pasted into the current application.

7‘ g5 [ie File Edit Format Window Help

About TextEdit

Preferences... 3,
BT ChineseTextConverter 4
. . Disk Utility >
H!de TextEdit _SGH Finder >
Hide Others " &H Font Book >
Show All Grab >

Quit TextEdit  2Q iClipboard > Paste iPod nano
| Import Image Paste Keauhou Reservation

SPECIAL SERVICES NOTE. Not all applications support services. Some popular applications like Microsoft Word
that were originally written using Apple’s Carbon technology do not support services. Most applications that
were written in Apple’s modern Cocoa do support services. Services are context-sensitive which means even an
application that does support services may not be able to use all services at all times. For example, if a service is
going to paste some text, but you're currently working on a document that can't be edited, the service will ei-
ther be disabled or won't show up.

SPECIAL NOTE FOR SNOW-LEOPARD & LION USERS. The Services menu looks and works slightly differently
under Snow Leopard and Lion. Under Snow Leopard and Lion, it's more context-sensitive which means you'll
only see services listed that are applicable for the current document. The services are also listed in a single
categorized list instead of hierarchically by application as shown below:

@& O30 File Edit Format Window Help
About TextEdit

Preferences... 8,

Services pictures % Capture Selection from Screen
i Import Image

Hide TextEdit  &H Paste iPod nano

;t‘;?”(ﬂ"ers ARall | @ Paste Keauhou Reservation

Quit TextEdit  3#Q

[ Services Preferences...

Snow Leopard and Lion also requires that you enable each service that you want to use. This means that you
need to enable each named clipping individually. Simply choose Services Preferences from the Services menu.

® O LY File Edit Format Window Help
About TextEdit

Preferences... &,

Services pictures 7 Capture Selection from Screen
2 Import Image

Hide TextEdit  H
Hide others Y 2H THHERTEIEN

Show All
Quit TextEdit  #Q

The Keyboard preferences will open in System Preferences and the Services item will be selected.
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®Or Keyboard
[ «|» || Showal | Q

Keyboard | Keyboard Shortcuts ]

To change a shortcut, double-click the shortcut and hold down the new keys.

¥ Dashboard & Dock [=] ¥Pictures

b Exposé & Spaces (] Capture Full Screen O

& Front Row = Capture Screen using Timer

Keyboard & Text Input [21 Capture Selection from Screen

" Screen Shots ™ Import Image

i+ Services ™ Paste iPod nano

& Spotlight

& Universal Access ™ Set Desktop Picture

A Application Shortcuts @ Messaging
@ New Email To Address
@ New Email With Attachment A
™ New Email With Selection v
[ +] - (" Restore Defaults )

p

Full Keyboard Access: In windows and dialogs, press Tab to move keyboard focus between:

(®) Text boxes and lists only
(U All controls

Press Control+F7 to change this setting.

(" Replacing Batteries... ) [ Set Up Bluetooth Keyboard... ) ('_7)

You can now simply find the named clipping like “Paste Keauhou Reservation” and make sure it is enabled. It
will now appear in the Services menu when applicable.

Searching

You can easily search all of your clippings or just the clippings in a certain project for a particular word or
phrase. iClipboard searches all of the text contained in text and web (html and web archive) clippings. iClip-
board will also search the name assigned to your clippings as well as any other pertinent data in clippings like
filenames for images, movies, etc.

To search your clippings:

1) Open the Shelf.

2) Choose a project from the Project button at the top of the Shelf.

3) Enteraword or phrase in the Search field. Only the clippings containing the word or phrase you entered will be
shown.
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Creating a Note From a Clipping

If you also use SOHO Notes by Chronos, you can create a new note directly from a clipping. The contents of the
clipping will automatically be saved inside of the note.

To create a note from a clipping:
1) Locate the clipping you want to create a note from.

2) Click the Action button in the Control Bar and choose Create Note. SOHO Notes will launch and a new note will
be created.

Rapid-Fire Copying/Pasting

Mac OS X only lets you put a single clipping on the system-wide clipboard at a time. This means if you're copy-
ing and pasting lots of information between applications that you have to switch between applications every
time you copy or paste something. iClipboard solves this problem by letting you copy multiple items to its clip-
board at a time; switch applications once; and then paste all of the items from the clipboard one at a time. For
example, you can press a special hot key five different times in your web browser to copy five different para-
graphs, and then you can switch to your word processor and press a special hot key five times to paste the five

clippings.

To copy and paste multiple clippings without switching applications needlessly:

1)  Switch to the application and/or document where you want to copy information.
2) Select the content you want to copy.

3) Press the special Copy hot key instead of pressing Command-C. A special lightning bolt symbol will appear next
to the clipping in the Shelf so you know it’s part of a sequence of clippings that you want to rapidly paste into a
different application.

4) Repeat steps 2 and 3 for each piece of information you want to copy.

5) Switch to the application and/or document where you want to paste all of the clippings and then click in the
document where you want the clippings pasted.

6) Press the special Paste hot key instead of pressing Command-V. The oldest clipping in the sequence of clippings
on the Shelf will be pasted and the lightning bolt symbol next to it will disappear.

7) Repeat step 6 for each special clipping on the Shelf. iClipboard will beep if you press the Paste hot key and there
aren’'t any more clippings in the sequence on the Shelf.

To specify the rapid-fire Copy and Paste hot keys:
1) Click the iClipboard icon in the menu bar and choose Preferences.

2) Select the Hot Keys tab.
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3) Clickin the Copy Hot Key field or the Paste Hot Key field.

4) Enter anew hot key or click Clear to delete the existing hot key.

Paste Blaster

Most Mac OS X users are familiar with the Command-Tab hot key which is used to switch between your running
applications. If you're familiar with how this Mac OS X feature works, then you already know how to use the
Paste Blaster. Simply press a special hot key and large previews from the selected project in your clipboard his-
tory will appear on your screen. Press the special hot key repeatedly until the clipping you want to paste is se-
lected and presto, the clipping will automatically be pasted into whatever application you're using.

e iClipboard

Shoot stunning 1080p HD
video everywhere you go.
With all-new optics, the
light is always right, the
color is always vivid, and
everything will look even
better than you
remember. Video
stabilization steadies
shaky shots. And you can

built-in-apps features features features

To use the Paste Blaster:

1) Press the Paste Blaster hot key (the default hot key is Option-Command-P). The Paste Blaster will appear
and the Cancel button will be selected.

2) Choose a project from the Project button in the upper-right hand corner of the Paste Blaster.

3) Continue to hold down the modifier keys (Option & Command in this case). As long as these modifier keys are
held down, the Paste Blaster will remain on the screen.

4)  With the modifier keys held down, repeatedly release and press the main key of the hot key (“P”in this case).
Each time you press the main key, the selected clipping in the Paste Blaster will advance. NOTE: you also hold
down the Shift modifier key to reverse the order that clippings are selected in.

5) Release the modifier keys to paste the currently selected clipping.
To specify the Paste Blaster hot key:

1) Click the iClipboard icon in the menu bar and choose Preferences.

2) Select the Hot Keys tab.
3) Clickin the Paste Blaster Hot Key field.
4) Enter a new hot key or click Clear to delete the existing hot key.

To enable/disable the Paste Blaster:
1) Click the iClipboard icon in the menu bar and choose Preferences.

2) Select/deselect Enable Paste Blaster.
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To limit the number of clippings in the Paste Blaster:
1) Click the iClipboard icon in the menu bar and choose Preferences.
2) Select the General tab.

3) Choose a limit from the Paste Blaster limit pop-up menu.

Ignoring Applications

You may not want to record clippings from certain applications. For example, you may not want to record the
passwords that are copied to the system-wide clipboard when you're using the Keychain Access application
that is part of Mac OS X. You can tell iClipboard to ignore clippings that originate in any application.

To not record clippings from an application:

1) Click the iClipboard icon in the menu bar and choose Preferences.
2) Select the Applications tab.

3) Click Add (+) to add an application that you wish to ignore.

4) Click Delete (-) to remove the selected application from the list of applications being ignored.
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Chapter 5—Projects

iClipboard can record and group clippings into projects that you define. For example, a scientist might switch to
her Research project when she’s doing research on the web and switch to her Report project when she’s work-
ing on weekly progress reports. Projects make it possible to compartmentalize your work.

The Project button at the top of the Shelf indicates the project that you're currently recording into. The Shelf
shows you all of the clipping in the currently selected project.

NOTE: every clipping is assigned to a project. The default project is the Unfiled project described below.

The “Unfiled” Project

iClipboard creates a special Unfiled project for you that can't be renamed, deleted, or locked. Whenever iClip-
board records a new clipping, it will automatically be placed in this Unfiled project unless you have another
project selected in the Project button at the top of the Shelf.

You can think of the Unfiled project as the project that holds all of the clippings that haven't yet been filed
elsewhere. If you don’t want to organize your clippings, you can, of course, just leave them in the Unfiled pro-
ject.

The “All” Project

The Project button at the top of the Shelf lists an All project. Select this project when you want the Shelf to
show every clipping regardless of which project it belongs to. In other words, “All” represents the master history
of clippings. When “All”is selected and a clipping is recorded, the clipping is assigned to the Unfiled project.

Setting Limits

iClipboard can conceivably record every clipping copied to the clipboard forever. As you might imagine, doing
so would consume a lot of memory and disk space. Fortunately, iClipboard lets you limit the number of clip-
pings recorded by limiting the clippings recorded into the Unfiled project. iClipboard only limits this project
because it assumes any clippings you save to other projects you want to keep forever.

You can limit the clippings recorded into the Unfiled project by quantity or by time period. For example, you
can tell iClipboard to only record the most recent 100 clippings or you can tell iClipboard to only keep clippings
from the past week.

You may also want iClipboard to ignore clippings if they are exceedingly large. For example, a graphics designer
that works with large graphic files may not want iClipboard to record a 50 MB image. Likewise, a movie editor
might not want a 400 MB movie clip recorded since doing so may affect the computer’s performance. iClip-
board lets you choose to record all clippings regardless of size or just those below a certain size.

To limit the total number of recorded clippings in the Unfiled project:

1) Click the iClipboard icon in the menu bar and choose Preferences.
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2) Select the General tab.

3) Choose a limit from the Unfiled limit pop-up menu.

To limit the size of clippings that are recorded into any project:
1) Click the iClipboard icon in the menu bar and choose Preferences.
2) Select the General tab.

3) Choose a limit from the Ignore clippings pop-up menu.

Working With Projects

Working with projects is easy since almost everything to do with projects starts with the Project button at the
top of the Shelf.

To add a new project:

1) Choose Edit Projects from the Projects pop-up menu. A sheet for editing projects will appear.
2) Click Add (+). A new project will be added to the list of projects.

3) Enter the name of your project and press Return.

4) Select the Lock button if you wish to prevent clippings from being added or moved to this project. See Locking a
Project for more information.

5) Click Done to exit the sheet.

To delete a project:

1) Choose Edit Projects from the Projects pop-up menu. A sheet for editing projects will appear.
2) Selecta projectin the list.
3) Click Delete (-).

4) Click Done to exit the sheet.

To rename an existing project:

1) Choose Edit Projects from the Projects pop-up menu. A sheet for editing projects will appear.
2) Double-click a project in the list.

3) Edit the name of the project and press Return.

4) Click Done to exit the sheet.

To switch projects:

1) Choose a project from the Projects pop-up menu. The Shelf will display all of the clippings that have al-
ready been recorded to the selected project.

To move clippings into project:

1) Select the clippings you want to move to a different project. Hold down the shift key to select multiple contigu-
ous clippings. Hold down the command key to select multiple clippings in a non-contiguous fashion.

2) Click the Action button, choose Move To, then choose the project you want to move the selected clippings to.
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To copy clippings into project:

1) Select the clippings you want to copy to a different project. Hold down the shift key to select multiple contigu-
ous clippings. Hold down the command key to select multiple clippings in a non-contiguous fashion.

2) Click the Action button, choose Copy To, then choose the project you want to copy the selected clippings to.
Since each selected clipping has now been duplicated, it will show up multiple times in the “All” project.

Locking a Project

You can lock a project to prevent clippings from being added or moved to it. A locked project can be identified
by the lock icon that appears next to the project name in the Project button at the top of the Shelf.

If a locked project is selected in the Project button at the top of the Shelf and a new clipping is recorded, the
clipping will be added to the Unfiled folder instead of the locked folder.

Note: the Unfiled project cannot be locked because it must always be available to accept newly recorded clip-
pings.

To lock a project:

1) Choose Edit Projects from the Projects pop-up menu. A sheet for editing projects will appear.
2) Select a projectin the list.

3) Select the Lock button.

To unlock a project:
1) Choose Edit Projects from the Projects pop-up menu. A sheet for editing projects will appear.
2) Select a projectin the list.

3) Deselect the Lock button.

Sorting

By default, your clippings appear in the order they were recorded, but the following sort order options are
available to you:

Date. Choose this option to sort your clippings by the date each was recorded.

Name. Choose this option to sort your clippings by the name, if any, assigned to each clipping.

Project. Choose this option to sort your clippings by the project that each belongs to.

Kind. Choose this option to sort your clippings by the kind of data stored in the clipping (text, image, movie,
etc.).

Application. Choose this option to sort your clippings by the application that the clipping was recorded from.
User-Defined. Choose this option to sort your clippings in the order that you drag them. The order that you
drag them is remembered on a project-by-project basis including the All project.

+4+ ++ 4

The sort order you choose is used in the Shelf, the Paste Blaster, and the iClipboard menu in the menu bar.
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To change the sort order:

1) Click the iClipboard icon in the menu bar and choose Preferences.
2) Select the General tab.

3) Choose your desired sort order from the Sort by pop-up menu.

4) Select the Sort in ascending order button if you want to sort in ascending order. This option does not apply if
you choose the User-Defined sort option.

5) If you've chosen the User-Defined option, then you can select a project in the Shelf and drag and drop the clip-
pings in the order you want them.
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